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Introduction

Color has the ability to communicate, to please, to excite, and to engage. Color makes
a difference—often a dramatic difference—in our photographs, our graphics, and our
layouts. Getting color right early in the workflow, and keeping it right to the end, is
increasingly critical in our fast-paced, deadline-driven digital world. Yet photographers
and designers are frequently dismayed when they print an image and the color is
wildly contrary to expectations. These disruptive surprises cost time and money, while
causing delivery delays and disappointed clients.

How can you make informed decisions during the production process so that the 
final result matches your intentions—and your client’s expectations—especially when
production involves multiple contributors in multiple locations using multiple applica-
tions and devices? 

Mac OS X provides a robust, standards-based solution for color management. It’s
called ColorSync, Apple’s universal color translator for delivering consistent and accu-
rate color across devices and at all stages of production. With ColorSync integrated
into Mac OS X and included at no additional cost on every Macintosh, it’s quick, easy,
and affordable to get started.

ColorSync extends the capabilities of creative professionals by making the manage-
ment of color effective, predictable, and practical. Participants in the creative and 
production process will experience these benefits:

• Accurate color that matches expectations

• Consistent color over time, across media, and using multiple vendors

• Better coordination among distributed team members

• Reduced production timetables, based on shorter and fewer review cycles

• Reduced costs, based on greater efficiencies, fewer paper proofs, and less rework 

• More satisfied clients, based on faster turnaround, lower costs, and higher-quality
product

ColorSync and Mac OS X deliver on the promise of higher productivity through the
accurate representation and consistent reproduction of color. The color you capture 
is the same color you see on the screen and in the finished printed product. No waste.
No surprises. No disappointments.
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How ICC Color
Management Works

Today’s creative workflows make use of a wide variety of imaging devices, such as 
digital cameras, scanners, printers, and computer displays. But for each device, the
same combination of numerical values will yield a different color. For example, a single
pixel where R=128, G=128, and B=128 should produce a completely neutral gray tone,
but on some devices the gray will look warm, or reddish, and on others the gray will
look cool, or bluish. These inherent disparities make it difficult to render the colors of
an image from one device to another with consistency, accuracy, and predictability.

The International Color Consortium (ICC) was established to address this problem.
Founded in 1993 by Apple and seven other vendors, the ICC now has a member base
of more than 70 industry-leading manufacturers and software developers, including
Sony, Hewlett-Packard, Creo, Adobe, and Quark. Their charter is to create and promote
an open color management architecture and vendor-neutral file formats. At the core
of their development efforts are the ICC profile and the Color Management Module
(CMM). Both are designed to ensure consistent color between applications, across
computing platforms, and across imaging devices.

The ICC Color Profile
Color management begins with the ICC profile, a cross-platform file format that
defines the color data required for calculating a color match between devices or
between working color spaces. Each ICC profile contains at least one pair of these
numerical values:

• Device-dependent data (for example, unique combinations of RGB values)
• The device-independent color produced by the device values

The device-independent color information is also called the Profile Connection 
Space (PCS).

Some device profiles, including scanner profiles, can have only device-to-PCS color
tables, because color only comes in from a scanner and out to other devices. Some
profile classes, such as printing press profiles, can have both device-to-PCS and 
PCS-to-device tables.

Conversion examples
• To view a scanned image on a display:

– Scanner RGB > PCS > Display RGB, using the scanner’s device-to-PCS table 
and the display’s PCS-to-device table

• To print the scanned image on a commercial printing press:
– Scanner RGB > PCS > Press CMYK, using the scanner’s device-to-PCS table 

and one of the press’s PCS-to-device tables

4Technology Overview
ColorSync in Mac OS X

Classes of ICC profiles
In addition to device profiles, the ICC has
defined other classes of profiles. Named Color
Profiles (NCPs) are used in spot-color systems
such as PANTONE, DIC, and Toyo Ink. NCPs
work in conjunction with other profiles to
process colors more accurately and to pro-
duce more faithful results on the display,
as well as on various printers. Another class 
of ICC profiles consists of abstract profiles,
which are used to produce an effect, similar
to a Photoshop adjustment layer.



• To print a proof of how the press will reproduce the scanned image:
– Scanner RGB > PCS > Press CMYK, using the scanner’s device-to-PCS table and one 

of the press’s PCS-to-device tables; then Press CMYK > PCS > Proofer CMYK using one
of the press’s device-to-PCS tables and one of the proofer’s (for example, Epson Stylus
Pro 7600) PCS-to-device tables

The Color Management Module (CMM)
The Color Management Module, or CMM, is a mathematical engine that performs color
transformations by connecting the source color space to the destination color space
through the PCS. The CMM converts a source profile (for example, a scanner) to a desti-
nation profile (for example, ColorMatch RGB) through the common PCS.

ColorSync translates color from one device to another through the Profile Connection Space.

To minimize the file size of device profiles, not every in-gamut color is included in the
color tables. This means the CMM might need to interpolate a color value if one is not
expressly defined in the destination profile. When the CMM encounters colors that do
not overlap, or are out of gamut, it looks to the rendering intent to determine the best
method of calculating the color transformation.

Rendering Intent
The rendering intent determines how the CMM will map colors from one device’s color
space to another’s. Each ICC profile is tagged with a default rendering intent (usually 
perceptual); but the user might prefer to select a rendering intent from within an appli-
cation, such as in Adobe Photoshop. The following four rendering intents are used to
reflect different imaging requirements.

Perceptual. Reproduces the relationship between colors by scaling the entire source
space into the destination space, including those colors that were in gamut. Perceptual
intent produces the most pleasing color results and is generally recommended for 
continuous tone photographs, where reproducing exact hues is not necessary.

Saturation. Reproduces the relative saturation of colors from gamut to gamut for 
the brightest, most vivid results. Saturation intent is designed primarily for business
graphics.
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Device Link Profiles
To remove the extra conversion step through
the PCS, two device profiles—for example, for 
the press and the proofer—can be merged
into one Device Link Profile using a tool such
as ColorThink from CHROMiX, Inc. However,
at this time not all applications and raster
image processors (RIPs) support link profiles.

A device’s gamut, the total number of 
reproducible colors, can be visualized as 
a 3D volume. Visualizing a device gamut 
in 3D is the most accurate way to see all 
the colors a device can produce. This can 
be seen using the ColorSync Utility.

Profile Connection Space



Relative colorimetric. Changes only the colors that fall outside the gamut of the 
destination device, often causing two colors that appear different in the source color
space to be the same in the destination color space. Colors are scaled relative to the
destination profile’s white point; the whitest white of the source space is mapped to
the whitest white of the destination space. In some instances, the relative colorimetric
intent produces a more appealing result than the perceptual intent.

Absolute colorimetric. Matches in-gamut colors exactly, reproducing the white point
of the source profile on the destination device, but clipping out-of-gamut colors to 
the nearest hue. Absolute colorimetric intent is best for rendering signature colors,
such as Coca-Cola red or Eastman Kodak yellow, and is most useful for soft-proofing.
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What Is ColorSync?

ColorSync is Apple’s implementation of the ICC specification, providing system-level
color management of images, documents, and devices. It is both an engine for pro-
cessing color and a framework for handling color on disparate devices. ColorSync in
Mac OS X v10.2 supports the current ICC specification, now at version 4.0, and can 
use all profiles from ICC version 2 forward, regardless of the operating system that 
created them.

Seamless Device Integration
ColorSync in Mac OS X effortlessly integrates all of your imaging devices, including
scanners, digital cameras, displays, and printers. This capability is made possible by 
a device registration database in Mac OS X, which automatically registers at least 
one profile for every imaging device the moment it’s first connected to a Mac OS X
system. The profiles in the device registration database can be recognized and used 
by applications in the digital workflow. For example, using Image Capture, the color 
in an image downloaded from a digital camera is translated on the fly to the display
when the file is opened in Preview, based on the profiles registered for the two devices.
When printing from Preview, the color in the original image is matched to the printer’s
profile. ColorSync automatically matches color from input device to display to output
device, adjusting the color characteristics and addressing the limitations of each
device in the workflow. (See page 15 for more information about Image Capture 
and Preview.)

Complete Integration into Mac OS X
In Mac OS X, ColorSync is fully integrated into the operating system, ensuring that
powerful color management tools can be accessed from every application. In fact,
Mac OS X v10.2 is the only operating system that fully supports the ICC version 4 
standard for managing color—delivering the industry’s most advanced OS-level 
color management system. This integration makes it easy for developers to build 
color management features into their applications and create products for greater 
productivity and higher-quality results.

In addition, a new Apple CMM in Mac OS X has increased the speed and precision of
color transformations. Matrix-based RGB-to-RGB color transforms take advantage of
the power of the G4 Velocity Engine to dramatically speed up the most common color
calculations; and the Apple CMM uses multiprocessing whenever possible for further
performance enhancements. As a result, color matching in Mac OS X v10.2 is nearly
twice as fast as in any previous version of the Mac OS.
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ColorSync features in Mac OS X v10.2
• Complete integration into the operating 

system
• Performance enhancements—twice as fast 

as in Mac OS 9
• New Apple CMM for superior image quality

and performance
• Full compliance with the ICC version 4.0 

standard
• High-quality default profiles 
• Greater control over profiles using the

ColorSync Utility



Getting Started 
with ColorSync

With ColorSync fully integrated into Mac OS X, it’s quick and easy to start managing
color—no complicated tricks or tools required. In fact, since ColorSync in Mac OS X is
always on, you might be working with color-managed images without even knowing
it. However, for better color results in a basic creative workflow, it’s important to
understand a few simple settings and procedures.

ColorSync Settings
Mac OS X v10.2 features a simplified System Preferences pane for ColorSync that
allows you to set default profiles and CMMs, making them automatically available to
all applications. To open the ColorSync preferences pane, choose System Preferences
from the Apple menu and click the ColorSync icon.

Setting default profiles
The Default Profiles tab lets you assign profiles for documents that do not contain an
embedded profile—so applications can always find a profile for every document.

Images without embedded profiles are assigned high-quality profiles. (The profiles 
shown above can be downloaded from the Adobe website.)

The CMMs tab lets you choose the Color Management Module to use when calcu-
lating colors. If the CMM preference is left as Automatic, ColorSync uses the CMM
specified in the source profile. Or you can choose the Apple CMM, which overrides 
the CMM specified in the source profile.
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Apple has been a leader in promoting 
and maintaining ICC-compliant color 
management since 1995. Most popular 
professional graphics applications, such 
as Adobe Photoshop, Nikon Capture, Corel
Painter, and GretagMacbeth ProfileMaker 
Pro, take full advantage of the power of
ColorSync and Mac OS X.



Choose the Apple CMM to make consistent, accurate color available to all applications 
in Mac OS X.

Displays and Display Profiles
Whether you’re a photographer or a designer, the display connected to your computer
is the window to your work. That’s why it’s crucial to select a digital LCD display that
represents colors faithfully—over a wide gamut and with little color deterioration 
over time. Frequent calibration and profiling are important, too. Mac OS X supports
color profiling of the computer display, using either the built-in Display Calibrator or 
a third-party calibrator and profiling software.

Choosing a display
Traditionally, CRT monitors have played an important role in color proofing systems.
In recent years, however, LCD technology has improved dramatically, giving LCD dis-
plays a distinct advantage over CRT displays in color-critical creative workflows. Today’s
best LCDs offer a wide color gamut, rivaling the best CRTs; excellent color uniformity
over the entire screen, thanks to wide-viewing-angle technologies; a consistent white
point, with less color deterioration over time; and higher brightness, crisper blacks,
and superior sharpness. LCDs are also less sensitive to the negative impacts of worst-
case viewing environments—such as very hot or very humid conditions—providing
more accurate and more predictable color in all scenarios.

Color on LCD displays is further enhanced by an all-digital connection to the com-
puter. Many LCDs rely on an analog interface (usually VGA); this interface requires 
signal conversions to the digital display, which can cause color shifts and problems in
brightness and contrast. Analog conversion problems become progressively worse as
you move to displays with higher resolutions or with longer cables. What’s more, the
controls used to drive a digital display with an analog signal often inhibit the display’s
ability to reproduce a wide dynamic range of colors. In contrast, all-digital connections
do not require any conversion, providing a distortion-free signal for superior clarity
and stability.

Display settings
As soon as you plug a display into a computer running Mac OS X, it communicates
industry-standard Extended Display Identification Data (EDID) information to the 
system. Based on this information, ColorSync automatically creates a display profile—
including the display’s native gamma (such as 1.8) and color temperature (such as
6500°K )—that reflects how the display shipped from the factory.
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Apple displays
Apple’s industry-leading LCD displays are
flicker-free, with twice the brightness, twice
the sharpness, and twice the contrast of 
typical CRT displays. Unlike other flat-panel
displays, they’re designed with a pure 
digital interface to deliver distortion-free
images and enable precision editing. Apple
displays offer a depth of 16.7 million colors
and let you see consistent color from a 170° 
viewing angle. For more information, see
www.apple.com/displays.

The new Apple CMM
At the heart of ColorSync in Mac OS X is a
robust new CMM. It is the core mathematical
engine that performs profile-to-profile color
transformations. The Apple CMM works with
available color profiles to display and print
color more accurately and more dependably—
without sacrificing performance.



An existing display profile can be assigned at the system level using the Color tab 
in the System Preferences pane for Displays. Click the Calibrate button to open the 
Display Calibrator.

The Color tab also gives you access to the Display Calibrator, which enables Mac OS X
to override the factory profile and create a profile that better conforms to your work-
ing environment. For example, you might want to change the white point from 6500°K
to 5000°K, or the gamma from 1.8 to 2.2. The Display Calibrator walks you through a
series of steps to adjust the brightness, contrast, and color balance—communicating
with the display using industry-standard EDID signals to identify the display, its 
native phosphor set, and its native white point. The end product is a fully functional
ColorSync profile that can be set as the display profile in System Preferences. By
default, ColorSync matches color only to the primary display (where the menu bar
appears); however, applications such as Photoshop can match to multiple displays
using ColorSync.

The Display Calibrator steps you through the calibration process to create a new 
display profile.
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Environmental considerations
The colors and lighting in your work space
can affect how you see colors onscreen and
in print. An evenly lit space (not too bright)
and neutral colors provide the best viewing
environment. A lightbox adds industry-
standard lighting, enabling you and others 
on the team—including your clients—to
view work under the same light. For even
finer control, you can set the lightbox to
match your display’s luminosity and balance
its color temperature.

Display Calibrator
The Display Calibrator is located in the
/Applications/Utilities folder. You can 
open it either by double-clicking the 
application icon (shown above) or by
clicking the Calibrate button in the
the Displays preference pane.



Monitor calibration devices
Some color-critical workflows demand superior display consistency, requiring the use
of an electronic calibration device—either a colorimeter or a spectrophotometer—
to create fine-tuned custom profiles. A colorimeter measures the luminosity of a few
specific colors. A spectrophotometer measures relative amounts of refracted light
across the entire visible spectrum. Recent improvements in colorimeter technology
make these devices an affordable choice for calibrating displays. Spectrophotometers
are more expensive, but provide a more accurate reading of color data and greater
versatility—since they can also be used to calibrate output devices. It’s a good idea to
calibrate a display at least once a month.

The most popular colorimeters and spectrophotometers are available for Mac OS X.
For more information, see the Macintosh Products Guide at www.apple.com/guide.

The ColorSync Utility
Every device connected to a Mac OS X system automatically registers a factory profile
and a default profile in the system’s device registration database. (For devices that 
register only one profile, the default and the factory profile will likely be the same.) 
In addition, a single device can have multiple modes—and therefore multiple profiles.
For example, a digital camera can have one mode for shooting indoors and another
for shooting outdoors. A printer can have a unique mode for each combination of
media and resolution settings.

Mac OS X makes the device registration database available to any application that
supports color management, enabling seamless device integration. The ColorSync
Utility, included in Mac OS X, gives you direct access to the database—so you can 
verify profiles, repair them, edit them, and add custom profiles that match your 
project needs.

Verifying and repairing profiles
Using Profile First Aid, ColorSync prevents a corrupt or poorly written profile from
bringing down your workflow. Profile First Aid verifies profiles in the database and
checks them for validity or corruption. If a profile doesn’t meet current specifications,
its data is invalid, or a tag is written incorrectly, Profile First Aid diagnoses the problem
and can repair it with the click of a button. Profile First Aid verifies only the format of
the profile and does not verify the accuracy of the color it describes.

When you click the Repair button, Profile First Aid repairs invalid profiles, leaving them 
in good condition for use by ColorSync-capable applications.
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The new ColorSync Utility makes it easy to
work with profiles in the device registration
database. The ColorSync Utility is located at
/Applications/Utilities/ColorSync Utility.



Viewing and editing profiles
For greater control, the ColorSync Utility allows you to open and edit any profile 
and to substitute customized profiles for generic, “factory-made” device profiles. Click
Profiles to display a list of all installed profiles. You’ll notice that every profile has an
internal name that describes the device and its utilization, in addition to file names
determined by the operating system that created them. For example, the file might
have been named “pcdcnycc.pf,” but its internal descriptive name is more complete:
“KODAK Photo CD Color Negative V3.0.”You can also use the ColorSync Utility to
inspect detailed information about each profile, including headers, tags, and color
gamuts. You can even plot the gamut as a 3D shape—making it easy to compare the
relative color spaces of different devices.

For more information about profile tags and other ICC specifications, see
www.color.org.

The ColorSync Utility categorizes devices by type in an easy-to-read list, similar to 
the Finder list view.

Creating custom profiles 
The quality of factory profiles is usually sufficient for the level of accuracy required 
in most workflows. However, to better represent your utilization of imaging devices,
the ColorSync Utility allows you to override the factory or default profiles and assign
custom profiles to the devices in your workflow. Several ICC profile creation and edit-
ing applications are available for Mac OS X; see the Macintosh Products Guide at
www.apple.com/guide.

For example, if you frequently print photographs on your USB inkjet printer with a 
particular combination of ink and paper, you might create or obtain a custom ICC 
profile for this exact scenario, or mode. If you primarily use a particular mode, such 
as glossy paper and full resolution, you can use the ColorSync Utility to set that as 
the default mode. Each time you print using ColorSync, your printer will use this 
custom profile.
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Profile locations
ColorSync profiles are stored in several 
locations in Mac OS X. The operating 
system installs profiles in a read-only 
location: /System/Library/ColorSync/Profiles.

Other locations allow users to access and 
edit the profiles.

• For all users of the same Mac system:
/Library/ColorSync/Profiles

• For each individual user of the Mac system:
/Users/username/Library/ColorSync/Profiles
(also referred to as
~/Library/ColorSync/Profiles)

• For access over a managed network:
/Network/Library/ColorSync/Profiles



Click the Current Profile pop-up menu and select the profile you want to use 
whenever the device is in the corresponding mode.
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Basic ColorSync Workflow

Mac OS X looks for an embedded profile in every image it displays, streamlining 
the most common color management workflows. The embedded profile tells the
receiving application how the image appeared on the originating scanner, camera,
or computer monitor—preserving its color quality and rendering it faithfully to its 
destination. The embedded profile moves with the image as it’s transferred from one
computer to another—making it possible to review and approve content across a
workgroup, via email, or on the web. Since it represents the original captured image,
and not necessarily the display of the originating computer, the embedded profile 
can have a significantly wider color gamut than that of the monitor used to create 
or view it.
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ColorSync in Action

Image Capture makes it easy 
to embed profiles in images 
as they’re downloaded from
scanners and digital cameras.

Digital Camera

Scanner

Computer Display

Proof Printer

Printing Press

Preview represents color-
matched source images 
onscreen for review and
approval.

Output profiles tell ColorSync
what to expect when printing
color-managed images.



Acquiring Accurate Color 
Image Capture is a powerful application included with Mac OS X. Plug in virtually 
any digital camera based on popular standards such as Picture Transfer Protocol 
(PTP) and USB Mass Storage, and Image Capture opens and recognizes the device—
without special drivers or image access software. By choosing a profile in the Image
Capture pane, you embed a profile into images automatically as they’re downloaded
or scanned, overriding the device’s factory profile. For even greater control, you can
change the profile for each image, for each session, or as you add new devices to 
the system.

Choose a profile to embed in the image as it’s being downloaded.

Image Capture also allows you to select the folder into which images are downloaded.
And by selecting an AppleScript script to run as images are downloaded, you can fully
automate your color management workflow—all within Image Capture. Just plug in
your camera and let Mac OS X, ColorSync, and AppleScript do the work.

You can also attach scripts to folders; anytime you add a file to the folder, the script 
is activated. For example, you can set up a job folder and attach a script that converts
downloaded images to a specific output profile. For more information about using
AppleScript, see the “Automating ColorSync with AppleScript” section or visit
www.apple.com/applescript.
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Embedding a profile in an image
Adobe Photoshop—and many other 
color-savvy applications—can embed,
or assign, profiles to a document. Mac 
OS X also includes easy-to-use scripts 
for embedding profiles in an image.
See /Library/Scripts/ColorSync.



Viewing Color-Managed Files 
The Preview application included in Mac OS X uses ColorSync to render the source pro-
file onscreen and when printing, making it possible to view and print color-consistent
images across different displays and printers. There’s no need to choose a profile, a CMM,
or a rendering intent; the file is automatically color managed.

Preview can open most graphics file formats, including PDF, TIFF, and JPEG files. If Preview
sees an embedded profile, it converts the source color space and renders it to either the
current monitor profile or the output printer profile. If no profile is embedded, Preview
uses Generic RGB Profile.icc, Generic CMYK Profile.icc, or another generic color space 
profile as the source color space. Other applications included with Mac OS X—such as
Image Capture and Mail—also use ColorSync to deliver images with embedded profiles
correctly to the display. This capability allows you to email color-accurate images or post
them to your website, making it easy for clients to review and approve them onscreen.

Using Mail in Mac OS X, you can email images with embedded profiles.

Apple’s Keynote presentation application also recognizes embedded profiles. As 
with displays, most projectors send EDID information, so ColorSync can automatically 
create profiles for them and render the colors faithfully to the projector. A product 
from GretagMacbeth, called EyeOne Beamer, can even calibrate and profile projectors
using the included EyeOne spectrophotometer.

For more control over color images, including simulating output devices onscreen 
and choosing CMMs and rendering intents for individual documents, see the “Putting
ColorSync to Work” section.
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Preview
The Preview application comes with Mac 
OS X and is located in the Applications folder.
Use Preview to open PDF documents and
image files in a variety of formats. You can
open it by double-clicking the application
icon shown above.



Printing Color-Managed Files 
Output profiles, or printer profiles, tell ColorSync what to expect when printing to the
final destination device. Most printer manufacturers provide ICC profiles in their device
drivers—improving the quality of color printed on their equipment without increasing
the complexity of their software.

The new Mac OS X Quartz printing architecture is enriched with ColorSync technology.
A document begins its path to a printer as a PDF spool file, which is prepared for 
printing based on information the computer receives from the printer. A source image
without an embedded profile is tagged with the corresponding generic profile. When
printing, ColorSync matches the source data to whatever profile has been pro-vided by
the printer driver. If a printer driver provides no profile, ColorSync matches the source
data to the corresponding generic profile (usually Generic RGB Profile.icc) and then
passes the data to the printer driver. This profile matching means that an image will
look the same on all displays and will print the same from all systems—even without
preexisting profiles. To make things even easier, Mac OS X has built-in drivers for many
of the popular raster printers from Canon, Epson, and Hewlett-Packard.

Images with and without embedded profiles are matched when printing to a 
raster printer. The Quartz print system uses ColorSync to assign or create source 
profiles as necessary, and the raster printer driver provides the output profile.

PostScript devices that use PostScript Level 2 and above also understand color 
management. When you print to a PostScript Level 2 or Level 3 device, ColorSync 
converts embedded ICC profiles to PostScript Color Space Arrays (CSAs) and has the
printer convert color to the destination space, called a PostScript Color Rendering
Dictionary (CRD). The CRD is the PostScript equivalent of an ICC output (printer) profile.

17Technology Overview
ColorSync in Mac OS X

Quartz Printing Architecture

Application

DeviceGray

DeviceRGB

DeviceCMYK

ICC

Calibrated

Quartz Printing Driver

Default Gray

Default RGB

Default CMYK

Use Profile

Make Profile

Output ICC



Putting ColorSync to Work

For more fine-tuned control over color transformations, many creative applications
provide sophisticated tools for managing color from document source to destination.
For example, Adobe Photoshop allows you to specify how to open color-managed
documents and enables you to assign profiles.

To illustrate how to get the most out of ColorSync in Mac OS X, this section uses
Adobe Photoshop 7.0—since its color management tools are representative of other
Adobe applications, as well as other popular applications for creative professionals.

Setting Up for Success
With a few simple steps in Color Settings, in the Photoshop menu, Photoshop can
help you establish consistent practices for color management across your workgroup.
You can configure Photoshop to use the ColorSync preferences you set in System
Preferences. Or you can use your ColorSync preferences as the basis for an Adobe
Color Settings File (.csf ), which can be inherited by all Adobe applications once it’s
saved using Photoshop.

RGB setup
Photoshop gives you predefined, device-independent RGB working spaces. You can
customize your working space using the RGB pop-up menu in the Color Settings
pane. Select the default source RGB working space for colors you create using RGB
color pickers and for RGB images with no embedded source profile. Adobe RGB (1998)
and ColorMatch RGB are popular spaces for photographers.

Photoshop automatically provides the conversion from the selected RGB working
space to your individual display. This conversion allows everyone in your workgroup 
to see the same color onscreen—provided they keep their displays calibrated and 
set Photoshop to the same RGB working space.

CMYK setup
Open the CMYK pop-up menu and choose your press, proofer, or standards-based
CMYK profile for colors you create using CMYK color pickers and for CMYK images
with no embedded profile.

The recommended set of RGB and CMYK profiles is available for download from the
Adobe website, making these high-quality profiles available to any application in 
Mac OS X. Or ask your printer to provide you with profiles for its devices.

18Technology Overview
ColorSync in Mac OS X

The Apple Color Picker
The Apple Color Picker is available to any
application, including the Finder. Each appli-
cation provides access to the picker in its
own way; most Mac OS X applications now
use the Colors icon. Select the Lists picker,
then choose any installed Named Color
Profile (NCP) from the List pop-up menu.
In the example above, the Web Safe Colors
NCP is selected.



Photoshop Color Settings enable you to configure your working spaces and set 
application-wide color management policies.

Color management policies
Photoshop enables you to set application-wide color management policies. The
Preserve Embedded Profiles option lets you open and save documents using their
original embedded document profile. This profile becomes the source space for 
your document, rather than the working source space for the color model. Using
Missing Profiles and Profile Mismatches, you can also tell Photoshop how to handle 
a document without a profile or with a profile that doesn’t match your current 
working space.

When you open an image without an embedded profile, Photoshop can notify you and
give you the opportunity to assign it a profile. (See “Assigning profiles” on the next page.)
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When you open an image that uses a different color space from your working space,
you can choose to preserve the embedded profile or to convert the profile to match 
your current working space.

Working with Color-Managed Files
While Color Settings enable you to set applicationwide choices, Photoshop also
enables you to manage color as you work with individual documents.

Assigning profiles
Using Image > Mode > Assign Profile, you can assign a selected profile to an image.
Particularly useful for shared documents, this embedded profile remains with the
image as it moves from your computer to any other application or device. Assigning 
a profile to an image defines how the pixel values in the file should be interpreted,
but does not alter the image data in the file. You can experiment using ColorSync
scripts or Photoshop to embed (or assign) different profiles to copies of the same
image, and evaluate how each profile affects the color.

Choose a profile to be assigned to, or embedded in, the document.
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Converting profiles
Using Image > Mode > Convert to Profile, you can convert an image’s colors to a
selected profile. Conversion alters the image data in the file, so the numbers produce
the right color in the destination color space.

Photoshop allows you to specify a CMM to perform the color conversion. If you select
ColorSync, the application will use whatever CMM you set in the ColorSync System
Preferences pane. The Convert to Profile pane also lets you change the rendering
intent, which gives the CMM the appropriate algorithm for profile-to-profile color
mapping; the default intent is from the source profile.

Choose a CMM from the Engine menu and a rendering intent from the Intent menu.

Soft-Proofing for Review and Approval
Soft-proofing means using the display to accurately represent the color of the final
output. Soft-proofing over the Internet can eliminate days from a production schedule,
especially when content creators and clients are distributed across the country or
around the globe. Adobe Photoshop builds on the capabilities of Mac OS X to enable
graphic designers, prepress houses, and printers to deliver an effective soft-proofing
solution.

Start by using View > Proof Colors to turn on soft-proofing in Photoshop. Next,
using View > Proof Setup > Custom, you can select the profile of the ultimate output
device as well as your rendering intent. This step enables Photoshop to simulate a
color-correct version of the final printed piece to the screen. Depending on the profile,
you can even choose to simulate white paper and black ink.

Choose a profile and a rendering intent to create a soft proof of your document.
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Facilitating client approvals 
Mac OS X applications—Mail, Safari, and
Preview—enable you to email or post 
documents for client viewing, without 
requiring them to use Photoshop. If you’ve
converted the document to the profile of 
the final printer, your clients can see color 
onscreen that will be representative of 
the printed result. In addition, clients with
supported printers can print color-accurate
proofs from their desktops—with no add-on
hardware or software required.



Working with Output Profiles 
A printer profile describes a combination of the printer, its substrate, and colorants
(inks or dyes). Many types of output devices are used with—and their corresponding
profiles are used in—Mac OS X:

• Printers that use four process colorants, typically cyan, magenta, yellow, and 
black (CMYK)

• Printers that use inks, dyes, and other colorants

• Printers that use red, green, and blue (RGB) signals, or an additive color system,
such as photographic film recorders or computer displays

Printer profiles are usually quite stable and will describe the capabilities of the device
for an extended period of time. If anything in the process changes significantly—
substrate, colorant type, or the device itself—it’s a good idea to obtain or make a 
new profile. Creating a new profile generally involves printing a special “target” and
measuring the color on the printed piece with a measurement device called a spec-
trophotometer. Profiling software analyzes the device and builds a printer profile that
represents its characteristics and provides the mathematical data required for color
calculations.

Once you’ve created a printer profile, you can save it in one of your ColorSync folders
(such as /Library/ColorSync/Profiles/) to make it available to all applications using
ColorSync. In addition, printer settings, profiles, and characteristics can be saved and
recalled at any time in Mac OS X using saved settings.
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Printing PDFs
Mac OS X makes it easy to “print” a file to 
disk, using the Save As PDF function, instead
of printing to an actual printer. In this case,
a PDF file is created, retaining all associated
profiles. Applications and systems that sup-
port and print PDF documents—such as
Adobe Photoshop—can acknowledge the
embedded profiles and use them to repro-
duce the document in correct, managed color.

When saving an image without an embedded
profile as a PDF file, ColorSync automatically
embeds the appropriate generic profile:
Generic RGB Profile.icc for RGB images;
Generic CMYK Profile.icc for CMYK images;
and Generic Gray Profile.icc for gray images.



Automating ColorSync 
with AppleScript

AppleScript is Apple’s tool for automating applications and workflows within the Mac
OS. Its unique ability to query and control applications makes it perfect for working
with ColorSync and ICC profiles. In fact, Mac OS X includes scripts for common color
management tasks, such as embedding a chosen profile in an image, removing a 
profile from an image, and displaying information about an embedded profile. These
scripts have been saved as droplets in Mac OS X, which means you can simply drag 
an image or a profile onto the droplet icon to trigger the selected task. All built-in color
management scripts can be found in /Library/Scripts/ColorSync/ColorSync/.

Attaching Scripts to Folders
It’s also possible to attach any color management script to a folder using Folder 
Actions in Mac OS X. Folder Actions enable a folder to activate a script when some-
thing related to the folder changes. For example, you can attach the “Convert to 
specific profile” script to a job folder, and any image placed in the job folder will be
automatically converted to the profile you’ve specified in the script (for example, a
press profile).

Folder Actions are easy to set up using the AppleScript menu. To add AppleScript to
your Mac OS X menu bar, go to Applications > AppleScript and drag the file “Script
Menu.menu” to the menu bar. The AppleScript scroll icon appears toward the right 
of the menu bar. Using the AppleScript menu, go to Folder Actions > Attach Script 
to Folder and follow the prompts to choose a script and a folder.

Creating Custom Scripts
Since AppleScript uses an English-like syntax, it’s easy to learn—even for nonprogram-
mers. To get started, you can open the included scripts using Script Editor in Mac OS X
and copy or modify code. Custom scripts can save you time, labor, and headaches in
everyday work.

Using AppleScript Studio, you can combine the power of AppleScript and ColorSync
with the look and feel of Mac OS X to create custom color workflow tools to share with
your workgroup. For more information, visit www.apple.com/applescript.
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Built-in color management scripts
Mac OS X provides scripts for these common
color management tasks:

• Build profile into web page
• Change display profile
• Embed chosen profile
• Embed display profile
• Embed specific profile
• Extract profile
• Match to chosen profiles
• Match to CMYK
• Match to specific profiles
• Mimic PC monitor
• PC to Mac Gamma
• Proof CMYK on display
• Proof to chosen profiles
• Proof to specific profiles
• Remove profile from image
• Rename profile
• Set profile info
• Show profile info



The “Match to CMYK” script matches an image to your default CMYK profile, as defined 
in your ColorSync Preferences. Using Script Editor, you can easily customize the script 
by replacing “default CMYK profile” with a standards-based profile of your choice.
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Additional Resources

For more information about how to use ColorSync in Mac OS X, we recommend the
following websites and books.

Websites
• ColorSync: www.apple.com/colorsync 

• Mac OS X: www.apple.com/macosx

• Apple displays: www.apple.com/displays

• AppleScript: www.apple.com/applescript

• Macintosh Products Guide: www.apple.com/guide

• Adobe technical guides: www.adobe.com/support/techguides/color

• Adobe profiles: www.adobe.com/support/downloads

• International Color Consortium (ICC): www.color.org

Books 
• Real World Color Management, by Bruce Fraser, Chris Murphy, and Fred Bunting

• Real World Adobe Photoshop 7, by David Blatner and Bruce Fraser

• Mastering Digital Printing: The Photographer's and Artist's Guide to High-Quality 
Digital Output, by Harald Johnson 

• Photoshop Color Correction, by Michael Kieran 

• Adobe Photoshop 7.0 for Photographers, by Martin Evening

• Adobe Photoshop Master Class, by John Paul Caponigro
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